
 
ThermaData® Studio Overview 

ThermaData Studio provides the ability to record and analyse temperatures from a number of 

sources, including ThermaData Loggers, Bluetooth Classic, Bluetooth LE instruments (Windows 10 

only) and USB Probes. 

ThermaData Studio provides the following ways of analysing information: 

• Data Summary 

• Active Instruments 

• Data View 

• Graph View 

• Probe Map 

• Span Window 

• Alarm History 

 

For a full explanation of these features, see the relevant Help section.   



Uninstalling the Software 

Windows 7/8/10 Main Desktop Software 

1. Close all running versions of ThermaData Studio. 

2. Open the ‘Control Panel’ from the ‘Start’ menu. 

3. Click on ‘Programs and Features’ and select ‘ThermaData Studio’. 

4. Click ‘Uninstall’ 

 

Windows 10 App 

5. Close all running versions of ThermaData Studio. 

6. Open the ‘Settings’ icon from the ‘Start’ menu. 

7. Click on ‘Apps’ and select ‘ThermaData Studio’. 

8. Click ‘Uninstall’ 

 

The installation will be fully removed, leaving only the data files you have saved. 

 

Home Pane 

Document Ribbon 

 
New opens up a new Active Instruments window and begins recording readings. 

Open allows you to open up previously saved ThermaData Studio (.msdb) files using Windows 

Explorer. 

Save will automatically save any selected file you have open.  

Close All Windows will close down all windows currently open in ThermaData Studio. 

 

Printing Ribbon 

 
Print will automatically print off the selected window in ThermaData Studio. If you require a graph 

to be printed, select the graph window and click ‘Print’. 

Print Preview opens up a window allowing you to view your file before you print.  



 

User Options 

To configure the options within the application, click on the ‘Options’ icon found along the bottom-

right edge of the ‘File’ menu dialog (or on the keyboard shortcut ALT+F and then I): 

 

Next, you will see all the options for the add-ins you have loaded: 

 

The various modules of the software are displayed together with the version installed. A green tick 

next to the module means it is up-to-date. A red cross means the module is out-of-date. When you 

next close and re-open ThermaData Studio this module will update to the latest version and show a 

green tick. 

 

 



The ‘Device Support’ page allows users to select the various ETI Ltd instruments that the software 

will be able to communicate with. To disable/enable an instrument tick/un-tick the relevant box, 

click ‘OK’ and then restart the software. 

Note: to maximise performance we recommend disabling all instruments which are not required 

 

 
  

The New Document Destination page allows the user to 

change the location for storing downloaded data. 

 

 

 

 

The Auto Recover page allows you to choose at what interval 

the program will auto-save copies of the currently open 

documents. 

 

 

 

 

The Units page lets you select the units of temperature 

measurement, the maximum accuracy being displayed, and the 

date and time format. 

 

 

The Privacy page allows the user to control information sent to  

and received from their PC. 

If the ‘Enable checks for new versions of software’ box is ticked, 

ThermaData Studio will use your internet connection to check 

the ETI Limited website for the latest software when it starts 

up. 

 

 



ThermaData® WiFi 

ThermaData® WiFi Overview 

 

ThermaData WiFi instruments utilise WiFi wireless technology. The instruments are a battery powered, cost-

effective, temperature monitoring system that remotely records the temperature of appliances and buildings. 

Each instrument transmits the recorded data to a WiFi router connected to the internet which can be accessed 

and viewed from a PC, or laptop anywhere in the world. 

 

Each instrument has an LCD displaying temperature, WiFi connection status, max/min recorded temperatures, 

alarm status and battery level. 

 

At programmable intervals, the instruments will record temperature from the sensors, recording up to a 

maximum of 18000 readings (9000 from each sensor). Each logger incorporates a red and green LED. The flashing 

green LED indicates that the logger is active/logging and the flashing red LED indicates that your customised pre-

set alarm limits have been exceeded. 

 

Inserting / Replacing Batteries 

Each ThermaData WiFi instrument is supplied with 2 x AA Batteries. The instrument has a removable battery 

cover located on the rear, which can be opened using the flat-blade screwdriver provided. 

Note - Removing the battery will NOT cause all stored readings to be lost. 

1. Place the instrument display-down on a solid surface 

2. Use the screwdriver to unscrew the battery cover screw 

3. Remove battery cover 

4. Remove batteries (top one first) 

5. Fit new batteries observing polarities marked on battery holder 

6. Replace battery cover, then tighten battery cover screw 

7. Recycle any old batteries according to local law 

  



Connecting Instrument to Wi-Fi – via PC or Laptop 

 

1. After inserting batteries into the ThermaData WiFi, wait until the instrument displays “nEEd Conn”.  

 

2. Using the USB lead provided, connect the ThermaData WiFi unit to your PC or Laptop. Open ThermaData Studio 
and select the ‘ThermaData’ tab and choose the ‘Connect Instrument to WiFi’ icon. 

 

3. Once you have clicked on that you can select the appropriate WiFi network from the dropdown box and enter the 
necessary details. You’ll see a green bar load across the screen while it is searching for the available networks. 

 

 
 
4. If the network you are looking for does not appear, you can also manually type in the Network Name, select 

“WPA2” as the Encryption, and then enter the Network Password. When complete press the ‘Set WiFi Network’ 
button to send the network information to the ThermaData WiFi logger.  

 

5. If the information sent is correct, the unit will display a WiFi signal indicator and a Cloud in the top left hand 

corner of the LCD. 

 
 



Connecting Instrument to Wi-Fi – via Mobile Device 

1. After inserting batteries into the ThermaData WiFi, wait until the instrument displays “nEEd Conn”. Press and hold 
both buttons for 5 seconds and the LCD display will show “SEt uP”: 

2.  
 

 

3. Within your mobile device settings, connect to the relevant WiFi 

network, example: “ThermaData WiFi Dxxxxxxxx”.  

('xxxxxxxx' is the serial number on the rear of your instrument).  

This will connect your phone to the WiFi logger as if it’s a router. 

 

 

 

4. Visit the following website: http://my.thermadatawifi/ 

Please ensure the phone is showing the connected to WiFi symbol before 

searching 

 

 

5. Enter your WiFi network details and click ‘Save Configuration’. The following sequence of screens will appear: 

 

 
 

6. The instrument will connect to the WiFi network and confirm it is connected. If the information sent is correct, 
the unit will display a WiFi signal indicator and a Cloud in the top left hand corner of the LCD. 

 

http://my.thermadatawifi/


Connecting to your Instrument in ThermaData Studio 
 

1. Press the ‘New’ icon under the ‘Home’ tab. 

2. The ‘Active Instruments” window will open as below: 

 

 
 

3. Click on the plus (+) symbol located at the bottom right of the window. 

4. Select ‘ThermaData WiFi’: 

 

 
 

5. Enter the serial number from the back of the instrument in the textbox, and choose whether you want ‘Read-

Only’ or ‘Full Access’ to the instrument. 

 

 



 

6. If selecting ‘Read Only’ the user will have limited access to the device and can only view and download 

information. Select ‘Read-Only’ and enter the 8 Digit Connection Key stated on the back of the instrument (2nd 

row). 

 

 
 

When selecting ‘Read Only’ the user can upgrade to full access at any time. Please see Active Instrument section 

on how to change this. 

 

7. If selecting ‘Full-Access’ the user will have unlimited access to the device and can adjust all the settings. Press the 

‘Start’ button on the instrument 5 times repeatedly. A unique pairing code will then show: 

 

 
 

Enter this into ThermaData Studio: 

 

 
 

8. If all details are correct, your instrument will appear in the ‘Active Instruments’ window as Active. 

 

 

 

 

 

 

 

 



Removing your instrument from ThermaData Studio 

1. Right-click on the instrument, or click on the ‘…’ icon at the end of the row, and choose ‘Remove this instrument 

from ThermaData Studio’. 

 

 
 

Select ‘Yes’ when prompted and you will be removed from the instrument. 

Please note: this will only remove the instrument from the ThermaData Studio running on this machine 

2. If successful the chosen instrument will move to a ‘Removed’ section within the Active Instrument window to 

show that the action has been complete. The instrument cannot be removed or deleted immediately because 

there could unsaved data points from this instrument. It will remain in the ‘Removed’ group until a new ‘Active 

Instrument’ window is opened.  

 

 

 

Removing others users from having access to your instrument 

1. Click on the ‘…’ icon at the end of the row for your instrument, and choose ‘Remove all other users from this 

instrument’’. 

 

 
 

Click  ‘Yes’ when prompted and all other users with access to this instrument will lose their access. 

 

Please note: this will remove the instrument from all other users ThermaData Studio. 

 

 

 

 



Renaming your instrument 

1. To rename a ThermaData WiFi instrument, right-click on the instrument name in the ‘Active Instruments’ 

Window, or click on the ‘…’ icon at the end of either sensor row for your instrument, and choose ‘Rename this 

instrument’. 

 

 
 

2. Type your new name, and then ‘Enter’, and this name will be communicated to all ThermaData Studio’s which 

have a connection to this instrument. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Setting up your Instrument 

1. Either press the ‘Instrument Settings’ icon on the ’Home’ tab or right-click on the 

instrument name in the ‘Active Instruments’ window, or click on the ‘…’ icon at the end 

of either sensor row for your instrument, and choose ‘Change Settings for this 

instrument’.  
 

 
2. When setting up via the icon (with multiple instruments connected), select which instrument you want to 

download from the drop-down menu provided. 

 

 
 

3. A setup window will appear with options to change the Sample Rate, Transmission Rate, Audit Check and 

Auto-Start. Choose your settings based on the requirements, and then press ‘Next >’. 

 

 
 

 

 

 



 

4. Choose your settings for Sensor 1 (Name and High/Low Alarm Limits), and click ‘Next >’. 

5. Choose your settings for Sensor Two (Name and High/Low Alarm Limits), and then click ‘Next >’. 

  
(Sensor 1 or 2 can be disabled by clicking the green slider at the top of the Setup window.) 

 

6. Check the settings you have chosen in the Confirmation window and click ‘Finish’. You will be reminded 

that sending settings to an instrument will remove all historic data from the instruments memory. 

 

 
 

7. ThermaData Studio will then queue your request in the ThermaData ‘Pending Requests’ window until the 

instrument next successfully communicates.  

 

 
 

8. To bypass this queue, you can either press the ‘Start’ button once on the ThermaData Logger to force a 

communication, or plug the instrument in via USB and go through sending the settings again. 

 



Retrieve & Downloading Data 

1. Either press the ‘Download’ icon on the ’Home’ tab or right-click on the instrument name in 

the ‘Active Instruments’ Window or click on the ‘…’ icon at the end of either sensor row for 

your instrument, and choose ‘Download data from this instrument’. 

 

 
2. When downloading via the download icon (with multiple instruments connected), select which instrument 

you want to download from the drop-down menu. 

 

 
 

3. ThermaData Studio will then queue your download request in the ThermaData ‘Pending Requests’ window 

until the instrument next successfully communicates.  

 
4. To bypass this queue, you can either press the ‘Start’ button once on the ThermaData Logger to force a 

communication, or plug the instrument in via USB and press download again. 

 

5. When the instrument successfully communicates the download will begin:  

 

 
 

6. The downloaded data will automatically be saved to the default directory, which is shown on the window that 

appears, if you press ‘Continue’, but there is an option to save to a new location if required by clicking on the 

‘Save As’. 

 
 

To change the default directory, select ‘Change Default Destination Directory’ in the window that appears 

after a download, or via the ‘New Document Destination’ within the ‘File > Options’ dialog. 



Getting Instrument Status 

Getting instrument status will obtain all the current information from the logger (not the historic data) without 

interrupting it from its current set up. 

 

1. Press the ‘Status’ icon on the ‘ThermaData’ tab. 

 

 
 

2. Select which instrument you want to get the status from within the drop-down menu 

 

 
 

3. ThermaData Studio will queue your request for the status, and open up a status window with last-

communicated information. This will then update every time the instrument successfully communicates. 

 

 
  



Setting Reading Trim 

This feature is only available when the instrument is plugged into USB on the computer running the ThermaData 

Studio software 

1. Connect instrument to PC via USB Lead. 

2. Press the ‘Reading Trim’ button on the ‘ThermaData’ tab. 

 

 
 

3. Reading Trim should not be adjusted unless you are certain the temperature is incorrect. The ThermaData 

WiFi Logger/sensors must be allowed time to acclimatise in a temperature controlled environment before 

the ‘Reading Trim’ should be adjusted. The “Reference Value” temperature should be taken from a 

certified, calibrated instrument and then entered into the ‘Temperature measured by higher-accuracy 

instrument’ dropdown box. 

Once this is done, click the ‘Update’ button.  

Note - trim should be done in the temperature range in which the instrument is going to be used.   

 

4. A password can also be set to prevent other users from adjusting this trim by pressing ‘Set Password’ and 

filling out the relevant information. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Monitoring wireless instruments via Active Instruments 

‘Active Instruments’ is the main location to view all your wireless instruments. This view is compatible with 

ThermaData WiFi, Bluetooth LE, Classic USB Probes and Classic BlueTherm instruments. It will automatically 

appear when you start ThermaData Studio if the device support for these instruments is turned on in ‘File > 

Options’. It will display all available instruments in as ‘Active’, ‘Late Instruments’ or ‘Removed’. 

 

 
 

 

 

 

 

The default layout shows the following columns: 

Sensor Name Shows the name of the sensor 

High Limit Shows the current High Limit set for the instrument 

Low Limit Shows the current Low Limit set for the instrument 

Reading Shows last transmitted reading from the instrument 

Last Updated Shows when the last reading occurred 

Access Level Shows Full or Read access 

Auto Archiving Shows whether you are auto archiving this instrument (green), not auto-archiving 

(red) or auto-archiving isn’t supported for this instrument (-) 

Configure Shows a list of actions available for each instrument 

Extra Columns available are: 

Instrument Name Shows the name of the instrument 

Serial Number Shows the serial number of the instrument 

Next Update in Shows the anticipated time till the next reading is transmitted to Studio 

Battery Level Shows the battery level of the instrument at the last update 

Signal Strength Shows the signal strength reported by the instrument at the last update 

Measurement Interval Shows the measurement (logging) interval the instrument is set to 

Transmission Interval Shows the transmission interval the instrument is set to 



 

 

To change the information displayed, right click on the title of any of the columns you will see the following 

options: 

 
1. Hide that specific column. (Sensor Name, Reading, Last Updated and Configure cannot be hidden) 

 

2. Manage Layout - You can move columns between ‘Available Columns’ (not shown) and ‘Show these 

Columns’ (shown) by selecting them and clicking ‘Add’ or ‘Remove’ as appropriate. Press ‘OK’ to confirm 

these changes. (Hold Ctrl to select multiple) 

 

 
 

3. To restore the layout to its default, click ‘Reset layout to Factory Defaults’. This will return the view to the 

default layout, as shown previously. 

 

 

 

Late Instruments 
 

Any instruments that do not successfully communicate for 2x transmissions (plus 1 minute) will automatically 

move to a ‘Late Instruments’ group. Each instrument will continue to re-connect, but ThermaData Data Studio will 

display the instrument in this way. If this occurs, please check the WiFi signal strength at the location of the 

instrument and/or the battery level of the instrument. 

 

 
 



Managing wireless instruments via Active Instruments 

 

To manage an instrument within the ‘Active Instruments’ window, right-click on the instrument name in your list, 

or click on the ‘…’ icon at the end of either sensor row for your instrument, and choose an action from the pop 

out window.  

 

With a ThermaData WiFi that is connected with full access and isn’t auto-archiving, you will get this menu: 

 
 

With a ThermaData WiFi that is connected with read only, you will get this menu: 

 
 

With a ThermaData WiFi that is connected with full access and is set to auto-archiving, you will get this menu: 

 
 

With a Bluetooth LE instrument connected, you will get this menu: 

 
 

On all these options screens you can change and configure each instrument and how it interacts with ThermaData 

Studio. 

 



Any sensor that has exceeded its high limit will become shaded in red. 
Any sensor that has exceeded its low limit will become shaded in blue. 
 

 

 



Auto-Archiving Data 

Overview 

This feature allows the user to save logged data from ThermaData WiFi instruments at regular intervals. The auto-

archive setup creates ThermaData Studio files and automatically stores them in as a ThermaData Studio (.msdb) 

file. The data is transmitted every 4 hours and appended onto the end of the files. Alarm summary documents are 

simultaneously created in PDF format and stored in the same file structure as the files to provide an easy to see 

record of the information that is of most concern. 

 

Auto-archive data can be stored on a local PC, on a server or on a cloud repository. 

 

Note - To be able to auto-archive data from a ThermaData WiFi instrument ‘Full access’ is required. 

 

IMPORTANT - It is recommended that only one user is responsible for the auto-archive set-up to ensure that no 

conflicts arise as a result of multiple users changing settings. 

 

Any other user who needs access to the ThermaData WiFi instrument to be able to view readings should be 

granted ‘Read-only’ access. This is to ensure that settings are not inadvertently changed in a manner that would 

compromise the archived data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Setting up Auto Archive via Active Instruments 

1. Right-click on the instrument name in the ‘Active Instruments’ window, or click on the ‘…’ icon at the end of 

either sensor row for your instrument, and choose ‘Set up Auto Archive for this instrument’. 

 

 
 

2. Choose a recording interval (logging rate) for this instrument and click ‘Finish’. These options are more 

restricted through Auto Archiving in order to maximise battery performance.  

 

 

3. ThermaData Studio will then queue your request in the ThermaData ‘Pending Requests’ Window until the 

instrument next successfully communicates.  

 

 
 

4. To bypass this queue, you can either press the ‘Start’ button once on the ThermaData Logger to force a 

communication, or plug the instrument in via USB and go through sending the settings again. 

 

 



Managing Auto Archive 

 
Pressing the ‘Auto Archive’ icon on the ’Home’ tab will show all instruments, groups, and the save file location for 
the current auto-archive set up on that PC or Laptop. 

 

 
 

Groups 

 
If you have multiple locations where your ThermaData WiFi loggers are monitoring you may want to separate the 

loggers via ‘Groups’. Type the name of the group in the field located at the bottom of the page and click on ‘Add’ 

when complete. 

You can add multiple groups as seen below: 

 

 
 



Adding Multiple Instruments 

1. Under the ‘Instruments’ option within the ‘Auto-Archive’ window, click ‘Add’ and follow the on-screen 

prompts. 

 

 

 

2. Select the desired loggers and click ‘Next’ 

 

 
 

 

 

 

 

 

 

 



3. The recording interval selected will apply to all of the instruments selected in the previous step. If the 

instruments need to have differing recording intervals select them individually in the previous step. 

Once the Recording Interval has been selected click ‘Finish’. 

 

 
 

4. If required, assign the instruments to one of the pre-named Groups using the drop-down menu.  

 

 
 

 

 

 

 

 



5. To access the settings of your auto-archived ThermaData WiFi loggers double-click on the instrument name. 

This will open a configuration window allowing you to change the Recording Interval, name of sensors and 

High and Low Limits. You can also disable any of the sensors by using the blue switch next to Sensor 1 or 

Sensor 2. 

To confirm changes press the ‘Change’ button at the bottom of the window.  

 

 
 

6. ThermaData Studio will then queue your request in the ThermaData Pending Requests Window until the 

instrument next successfully communicates.  

 

 
 

7. To bypass this queue, you can either press the ‘Start’ button once on the ThermaData Logger to force a 

communication, or plug the instrument in via USB and go through sending the settings again. 

 

 

Remove Instrument from Auto Archive 

 
To remove an instrument from Auto-Archive select it on the ‘Instrument’ window and press the ‘x’ at the end of 

the line. 

 

 
 

 

 

 

 

 

 



Setting Auto Archive Save Directory  

The ‘Archiving’ option gives you the ability to select the directory/file path of where you want your data to be 

saved to. You can enter this by clicking on the ‘…’ button at the end of the box and selecting a location. 

 

“Sort By” gives you the choice of how your data is saved in the folder. There are 3 dropdown boxes, and starting 

from top-to-bottom you get multiple choices on how the data is viewed. In the example below, the data is saved 

as “Year > Groups > Month”.  

 

 
 

To preview how the data will be viewed with in the folder, press ‘Preview’ and a new window will appear as 

below: 

 
 

Once you have ensured all settings are correct, confirm all the changes by pressing ‘OK’ to close the auto-archive 

window. 



To view Auto Archived data, navigate to the file location on your PC or Laptop, where you will find both the .msbd 

files (only compatible with ThermaData Studio) and .pdf (Alarm Report) sorted as selected. This list will update 

each time an instrument successfully transmits new data into ThermaData Studio.  

 

 
 

IMPORTANT: ThermaData Studio is required to be open for Auto Archiving to regularly update saved files. 

 



TD Link – Mobile Notifications 

Pairing with ThermaData Studio with TD Link 
TD Link is a mobile application on both iOS and Android, which allows users to view current data 

from all the ThermaData WiFi instruments paired with ThermaData Studio.  

Note: TD Link is only compatible with ThermaData WiFi Instruments. 

1. Press the ‘TD Link’ icon on the ’ThermaData’ tab 

 
2. Create an account by entering your email address and a memorable password.  

3. Once entered press ‘Register’ 

  

4. The window will then show the email address of which account is now currently set up on this PC 

or Laptop. There will also be options to ‘Change Password’, ‘Log Out’ or ‘Unlink’ these details 

from the software. 

(Unlink would be used in the instance of linking your account to a different PC.) 

5. On your iOS or Android Mobile Device, navigate to the App Store, and simply search for ‘TD Link’ 

6. After downloading, enter the App and you will be prompted to enter your account information 

you previously created.  

7. Press ‘Link’ and the TD Link will be linked with ThermaData Studio, and will display all the current 

data from all ThermaData WiFi instruments that are currently connected to ThermaData Studio. 

 

 



Viewing Data via TD Link 
 

Within the TD Link App, you will find a similar screen to the 
below. You will be able to see the most recent 
temperature reading, name of instrument, name of each 
sensor, time elapsed since last transmission, serial 
numbers and battery levels. 
 
 
A ribbon at the top of the app shows how many 
instruments are currently paired which have no alarm 
limits broken. If an alarm is broken then another band will 
display in red stating the number of instruments that have 
exceed their alarms limits or require attention. Any 
instruments which have low battery or missed their last 
communication will also appear here. 

 
 

If you tap on the instrument more information is displayed 

which shows the high and low alarm limits.  

You can see on our example that the “Walk in Freezer” 

sensor for the “Central Processing Unit” logger exceeded 

its low alarm of -18.0°C. That same logger was also running 

on a low battery which is also highlighted red. 

Note - As with all ThermaData WiFi instruments, the logger 

will force through a transmission whenever a high or low 

alarm has been exceeded even if the transmission interval 

has not elapsed. 

When an alarm limit is breached a push notification will get sent through to your mobile. This will 

appear on your lock screen or notifications screen as the sensor name and a description as to what 

alarm has occurred. 

 

 



Whilst in the app you can ”click again for more” (double 

tap) on any instrument to view more information. This will 

open a screen containing the following: 

• Current temperature 

• Maximum temperature 

• Minimum temperature 

• High alarm limit 

• Low alarm limit 

• Battery level 

• Last time and date the logger communicated 

• When the settings were last updated 

• Sample rate 

• Transmission rate 

• And an option to disable notifications for that 

particular instrument 

Back on the main screen the menu bar in the top-left 

corner can be selected to disable/enable notifications for 

all instruments, what temperature units you want to 

display the loggers in, e.g. °C, °F, and an option to hide any 

inactive instruments which haven’t communicated for 

over 7 days. 

Unlike email and SMS alerts the software on the PC does 

not need to be open and running, as the TD Link will 

access the Cloud rather than the software. The app can 

either be running in the background or closed for the 

notifications to work. 

If you add more ThermaData WiFi loggers onto your ThermaData Studio on the PC they will appear 

in the TD Link app. 

There are no limitations to how many mobiles your login can be used for, so this can be shared 

within the workplace so other users can be notified of temperature alarms. 

 



Android Alert Link 

Overview 

ThermaData Alerts or Android Alert Link is a mobile application on Android, which allows users to view current 
data from all the ThermaData WiFi instruments paired with ThermaData Studio 

Note - This feature only works with ThermaData WiFi Loggers. 

 

Setup via ThermaData® Studio 

 

First make sure your ThermaData WiFi Loggers are connected to a WiFi network and paired with ThermaData 
Studio.  Please see the ‘ThermaData WiFi’ help section for more information. 

Once all of your ThermaData WiFi Loggers are connected, click on the ‘Android Alert Link’ button in the 
‘ThermaData’ tab: 

 

 

 This will open a QR Code window with a unique code that will be scanned by the Android ThermaData Alerts app. 

 

 

 

 

 

 

 

 



Setup via ThermaData Alerts on Android 

 

On your Android Mobile Device, navigate to the App Store, and simply search for ‘ThermaData Alerts’ 
 
After downloading, enter the App and click on ‘Link Alerts’. 
 

 
 
Scan the QR Code in ThermaData Studio and confirm the QR Check Code matches. 
You will now receive temperature alerts for every ThermaData WiFi Logger connected to your ThermaData 
Studio. 

  
 
This feature will allow push notifications to be received even when ThermaData Studio is closed or the computer 
is off. 
 

Turning Off Alerts 
 
Open the ThermaData Alerts app and turn ‘OFF’ alerts to temporarily turn off notifications on your Android 
device but stay paired with ThermaData Studio.  Notifications can be turned back on at any time by repeating 
the process and turning ‘ON’ alerts. 
 

Unlinking Alerts 
 
Press ‘Unlink Alerts’ to turn off notifications and unpair your Android device from ThermaData Studio.  Once this 
is done you will have to rescan the QR Code in ThermaData Studio to resume push notifications. 



Email Alerts 

Overview 

Email Alerts enables you to send alerts via email for the following devices: 

• ThermaData WiFi 

• RF ThermaData 

• BlueTherm Classic  

• Bluetooth LE products (Windows 10 Only) 

• USB Probes 
 

 

Getting Started 

Select the ‘Email Alerts’ icon found on the ‘Home’ tab and the Getting Started tab will automatically open. This 
provides information on how Email Alerts work. 

 

 

 

 

 

 



Setting up Email Alerts 

Email Settings 
 
To sign in via Gmail click ‘Sign in to send by Gmail’ option in the blue box and follow the steps that appear on your 
web browser.  

To sign in via Outlook click ‘Sign in to send by Outlook.com’ option in the orange box and follow the steps that 
appear on your web browser  

Alternatively, enter your email address into ‘Send Email as’ followed by your ‘Server Name’, ‘Server Port’, email 
address in the ‘Username’ box and your ‘Password’. All of this information, including connection type can be 
retrieved from your IT department or ISP 

To confirm the information has been entered correctly click ‘Send test email’. This will send an email to the 
“sending” email address that you entered within this window. Please check your inbox to confirm receipt and that 
all the settings are correct. 

 

 

 

 
 
 
 
 
 
 
 



Alarm Filters 

 
For each Probe you do not wish to receive alarms, un-tick the relevant box [Enter High Limit, Leave High Limit, 

Enter Low Limit or Leave Low Limit]. You can also set a variable time delay before any emails are sent which helps 

with preventing false alarms during defrost cycles. 

Any sensors set-up in auto-archive will automatically be selected on for all alarm limits. This can be seen with the 

padlock symbol below: 

 

 

Enter High Limit - when a sensor exceeds its higher alarm limit 

Leave High Limit - when a sensor falls back below its higher alarm limit, and within its limits 

Enter Low Limit - when a sensor exceeds its lower alarm limit 

Leave Low Limit - when a sensor falls back above its lower alarm limit, and within its limits 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Email Destinations 
 

Under the ‘Email Destinations’ tab enter any email addresses at the bottom of the window that you want to 
receive email alerts to. When complete press the ‘Add’ button 
 
Repeat the above process for all of the email addresses you wish to use 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



ThermaData WiFi – Alerts 

 
The final tab in the Email Alerts window gives you the option to receive additional email alerts from the 
instruments. 
 
By ticking the check boxes, you enable ThermaData Studio to send email alerts if the logger misses its last 
communication or if the ThermaData logger has a low battery. By unticking the check box, you disable the 
function. 

 

 



  

ThermaData® Lite 

ThermaData® Lite Overview 

 

The ThermaData Lite is a high capacity logger used to record temperatures at specified intervals over the range -40 °C to 

85 °C with a resolution of 0.1 °C and an accuracy of ±0.5 °C at 25°C. 

 

The recording interval can be set anywhere from 6 seconds to 255 minutes in 6 second increments up to 1 minute and 1 

minute steps thereafter. 

It can also be programmed with various start/stop modes: 

 

 
 

Start Modes  

Manual Start Start the logger by pressing the button on the front case of the logger 

Start Delay Button press activates Start Delay if chosen. Various options are available 

Starts At Time The logger will start at the specified date/time without further intervention 

Start at temperature 
The logger will start at a specified temperature. User specifies if it is a rising or falling 
temperature that triggers the start. Time options are available as a backup should the 
temperature not be reached 

 

 

 

Alarm limits can be set for Over Temperature and Under Temperature. These would normally be set to levels acceptable 

for the environment in which the instrument is recording. A quick check of the alarm status can be obtained by pressing 

the button on the ThermaData Lite.  

For a description of the other LED indications, see the Button and LED indicators section. 

 

An Instrument name can be entered into the ThermaData Lite to aid the use of multiple loggers; this can be up to 31 

characters except the following. \ / : * ? < > | - 

Stop Modes  

When connected to PC The logger will stop and the PDF document will be generated 

Stop when full The logger will take 16000 readings and then stop 

After x readings The logger will  stop at a selected number of readings (up to and including 16,000) 

Stop At Time The logger will stop at the specified date/time without further intervention 

Stop on button press The logger will stop when the button on the logger is pressed for 5 seconds. 



  

The ThermaData Lite can also store trim data for improved accuracy. This feature can be password protected for 

security. The password is case sensitive and can be any characters except the following. \ / : * ? < > | - 

Connecting ThermaData® Lite to a Computer 

The ThermaData Lite is connected to a computer using a USB C lead. 

Lift the protective cap on the rear of the ThermaData Lite and insert the USB connector (Note - the connector is NOT 

polarised and therefore can be inserted in either orientation). Push it in until a click is heard. 

Connect the other end of the USB lead to a spare USB port on your computer. 

Once connected, communications to the ThermaData Lite will automatically begin. The ThermaData Lite acts as a 

memory card and provides a PDF summary page of the logged data. 

While the data is being downloaded for the PDF the red LED on the instrument will flash. This can take up to 1 minute 

depending on the amount of data stored. 

Now that the PDF has been generated it is stored in the logger until a new log is started. 

 

On disconnection, remove the USB C lead from the instrument and ensure the cap is pushed firmly back in place. 

 

Note - If it is the first time the ThermaData Lite has been connected since a battery replacement then the PDF will need 

to regenerate and the unit will need a ‘Factory Reset’ in ThermaData Studio before use. If the PDF is required please 

open or save it before performing the ‘Factory Reset’. 

 

 

 

Battery Replacement 

 

Note - Removing the battery will NOT cause all stored readings to be lost 

 

The ThermaData Lite battery has an expected life of 3 years at ambient temperatures. The ThermaData Lite case has a 

snap fit rear cover which can be removed by inserting a suitable coin in the slot provided and levering the cover off. 

Once the case is apart the battery can be seen and removed. 

When removing the battery, it is important to note the orientation and polarity. The battery holder is also marked with 

the polarity for the battery. 

 

It is recommended that only the Green Energy GEBC ER14250 batteries supplied by ETI Ltd are fitted. However if fitting 

a third party battery, fit only a 3.6V, ½AA size inorganic lithium battery that has an operational temperature range equal 

to or greater than the ThermaData Lite (-40 to 85 °C). Fitting a third-party battery may significantly reduce the battery 

life of the instrument. 

 

Once the battery is fitted replace the cover, aligning the marks on the edge of the case and snap together. 

 

Once the battery has been replaced a factory reset is required before the ThermaData Lite can be used. 

 

 

Factory Reset 

 
The ThermaData Lite can be reset to factory settings by selecting the ‘Factory Reset’ option found in the ‘ThermaData’ 

tab. 

A verification window will have to be acknowledged before the actual reset occurs as all settings, activities and data will 

be lost in the process. 



  

 

 



  

Button and LED Indicators for ThermaData® Lite 

The ThermaData Lite has 1 button and 2 LEDs (one red, one green). 

The Loggers button is initially used to start the logger. Once disconnected from the computer a single press will activate 

the logger to start (this will be indicated by the red & green LED flashing 4 times together). The logger is now waiting for 

the selected start criteria to be met (delay, at a temperature) before it will start taking temperatures. 

Button Action Action 
LED Flash 

configuration 

Number of 

flashes 
Next step 

Press To activate logger 
Red & Green 

together 
4 times 

Logger starts when 

criteria is met 

If the button is pressed after the logger has been activated, but before the start criteria has been met, it will indicate by 

flashing the red & green LEDs alternately twice. 

Button Action Action 
LED Flash 

configuration 

Number of 

flashes 
Next step 

Press 
Waiting for start 

criteria to be met 

Red & Green 

alternately 
2 times Starts Logging 

Once the logger has started logging temperatures, if the button is pressed it will indicate if any of the readings taken so 

far are inside or outside of the set Alarm limits. The green will flash 3 times if all readings are inside or the red LED will 

flash 3 times if any reading is outside of the limits. 

Button Action Action 
LED Flash 

configuration 

Number of 

flashes 
Next step 

Press 
Check alarms- 

Has exceeded limits 
Red 3 times --- 

Press 

Check alarms- 

Has not exceeded 

limits 

Green 3 times --- 

Once the logger has started logging temperatures the button can be held for 5 seconds to stop the logger. The logger 

cannot be restarted until it is connected back to ThermaData Studio. 

Button Action Action 
LED Flash 

configuration 

Number of 

flashes 
Next step 

Hold 5secs Stop Logging Red on for 4 secs Once 

Must connect to 

ThermaData Studio 

now 

Once the logger has stopped logging (stopped with the button hold, the number of readings has been met or the stop 

time has been met), this will be indicated by a 1 second red LED flash twice. 

Button Action Action 
LED Flash 

configuration 

Number of 

flashes 
Next step 

Press Check status Red on for 1 sec 2 times 

Must connect to 

ThermaData Studio 

now 

When the logger is connected to a computer the red LED will be continuously illuminated or flashing very fast. This 

indicates the connection to USB is good and that the data is being downloaded. 

Button Action Action 
LED Flash 

configuration 

Number of 

flashes 
Next step 

--- Connect to USB Red Flash continuous --- 

 

Note - If the battery level drops below ¼ on the bar scale in ThermaData Studio, the LEDs will not function. This is to 

ensure if the battery level drops to this level while the instrument is taking readings, it will still reach the end of its log 

without completely draining the battery. 



  

Setting Up ThermaData® Lite 

The set-up of the ThermaData Lite can be achieved using the Settings window. This window can be accessed using the 

‘Instrument Settings’ button under the ‘ThermaData’ tab. 

 

 
 

Once the Settings window is open you may change any of the settings within the ThermaData Lite. The following list 

shows the elements of the Settings window that can be modified: 

• Name 

• Battery Level  

• Alarm Temperature Limits – the over/under temperature alarm levels. 

• Starting Logger – the time the logger will wait before taking a reading after it has been started, a specific 
time/date to start the logger, or at a certain temperature.  

• Current Status - If the ThermaData Lite has already been started and is counting down the start delay, then the 
start delay time shown will be updated with the remaining start delay each time the logger is accessed. 

• Stopping Logger – the choice on how the logger stops taking readings. This can be done when the logger is full, 
after a set number of readings, or at a specific time/date. There is also a check box to enable/disable the stop 
function by holding the button on the ThermaData Lite. 

• Instructions – 7 lines of instructions to display on the PDF report when it is next generated. 

• Log Interval – how often your logger takes a temperature 
Note - the indicator below the dropdown box shows the total time before the memory becomes full. This 
automatically updates whenever the sample rate is changed. 
 

When you click on the ‘Instrument Settings’ button you may be asked which communications method to choose from. 

Using the dropdown box select “ThermaData Lite D********” as shown below. 

 

 
 

Note - Checking the ‘Don’t show this every time’ box causes the application to automatically select the last used COM 

port. To change this setting once checked use the ‘ThermaData Logger – Selected Ports’ tab in the ‘Options’ dialog. 

After the communications are complete the Settings window will open up.  

 



  

New settings cannot be sent to the logger unless it receives a ‘Stop’ command beforehand. 

 

‘Send Settings’ will send the new settings over to the ThermaData Logger and put the logger in a “Start state”. This 

means the logger will not start until it receives a ‘Start’ command (see relevant help section). This function is useful for 

allowing a ThermaData Logger to acclimatise before starting. 

 

If new settings are sent to the ThermaData Logger you will be prompted that this will delete any existing settings and 

temperature data that are currently stored on the unit. 

 

IMPORTANT - This information cannot be restored once deleted. 

 

 

Viewing Status 

Getting instrument status will obtain all the current information from the logger (not the historic data) without 

interrupting it from its current set up. 

 

Press the ‘Status’ icon on the ‘ThermaData’ tab. 

 

 

Select which instrument you want to get the status from within the drop-down menu, and press ‘OK’. 

 

 
 

ThermaData Studio will open up a status window containing the following information: 

 

 

• Serial Number of ThermaData Lite 

• Instrument Name 

• Firmware version 

• Earliest and latest reading time/date 

• How the logger was started 

• Recording Interval 

• Sensor high and low alarm limits 

• Total time logging 

• Number of readings 

• Number of readings in alarm 

• Max temperature/average temperature/min 

temperature 

• Total time in alarm 

• Total time out of alarm 

• Battery Level 

 

 

 

 

There are also separate options to select ‘Reading Trim Info’ which will show the trim amounts, and the date the trim 

was set, as well as the ‘Internal Time Info’ of what time and date the ThermaData Lite last read.  

You can also download the readings via the ‘Download Now’ button, or open the generated PDF by clicking ‘Open PDF’. 



  

Downloading Data from a ThermaData® Lite 

 

Once the ThermaData Lite has been plugged into the communications port you can select the ‘Download’ icon which 

can be found under the ‘Home’ tab. 

 
 

Select which instrument you want to download from within the drop-down menu, and press ‘OK’. 

 

 
 

Once you select the required option a communications window will open to indicate the progress of the download. 

 

 
 

The file will automatically be saved in the pre-set default directory by pressing ‘Continue’. This will be your ‘Documents’ 

folder as standard. You change the default directory by selecting ‘Change Default Destination Directory’ in the window 

that appears after a download, or via the ‘New Document Destination’ within the ‘Options’ dialog. 

 

 
 

To save the file as a different name or in a different location you can select ‘Save As’. 

The filename will be generated from the Title contained within the ThermaData Lite 

 

 

.Auto PDF 

 
When the ThermaData Lite is initially connected to a computer it will automatically generate a PDF summary of the 

logged data. Whilst the PDF is being generated the green LED will flash, this can take up to 1 minute depending on the 

number of readings in the logger. 

Once the PDF summary is generated you will be able to communicate with the logger through ThermaData Studio. 

The PDF summary will remain stored in the logger until a new log is started, at which time the PDF will be cleared, 

except when using the ‘Start at Time’ start mode, in which case the PDF will be cleared as soon as you disconnect the 

instrument from the PC. 

 

 



  

Data Retrieval 

 

If the instruments battery goes flat, when it is replaced the instrument will go through a data retrieval function which 

will read all of the readings stored in memory in order to create the PDF document. 

Whilst this is happening the Red LED will be solid with the Green LED flashing. This can take up to 2 minutes for 16,000 

readings. 

 

Note - If the instrument was logging at the time of power loss, it will not continue to log when the battery is replaced. 

 

Re-Initialising a ThermaData Lite 

Once a download has been completed you will need to re-initialise the logger to begin another logging cycle. 

The initialisation can be achieved in one of 2 ways: 

• Press ‘Initialise Existing Settings’ icon on the ‘ThermaData’ tab. This will re-initialise your ThermaData Lite with 

the same settings used in the previous logging cycle. 

 

• Use the ‘Instrument Settings’ window and following the “Setting Up ThermaData® Lite” section.  

 

 

 



  

Reading Trim 

The Reading Trim facility can be accessed by clicking on the ‘Reading Trim’ button found on the ‘ThermaData’ tab. 

If you have multiple instruments connected to your PC you will have to select the correct serial number from the drop-

down box. 

Any data in the logger at this point will be lost so ensure all data is downloaded and saved first. 

 

 
 

The ThermaData Lite must be allowed time to acclimatise in a controlled environment before the Reading Trim should 

be adjusted. The actual temperature of the controlled environment should be read from a certified, calibrated 

instrument. Now set the ‘Reference Value’ in the Reading Trim window to match the actual temperature. Once this is 

done, click the ‘Update Trim’ button. The Reading Trim of the ThermaData Lite will then be set according to the 

reference temperature. 

 

It is recommended that the Reading Trim be set as near to the temperature that the unit will be recording in as is 

possible. 

 

There is also a Reading Trim password that adds an optional level of security to the Trim settings. The existing Trim 

Password is required before changing the password or modifying the Reading Trim setting. 

 

If the Reading Trim password is forgotten, a factory reset will clear the password to nothing, although all data and 

settings will be lost. 

 

 

 

 

 

 

 

 



  

Stainless Steel Pro Logger 

Overview 
 

The Stainless Steel Pro is a high capacity logger used to record temperatures at specified intervals over the range -20 °C 

to 125 °C with a resolution of 0.1 °C and an accuracy of ±0.5 °C at 25°C. 

 

The recording interval can be set anywhere from 1 second to 255 minutes in 6 second increments up to 1 minute and 1 

minute steps thereafter. 

It can also be programmed with various start/stop modes: 

 

 
 

Start Modes  

Manual Start Start the logger by pressing the start button in Studio. 

Start Delay Studio Start button press activates Start Delay if chosen. Various options are available 

Starts At Time The logger will start at the specified date/time without further intervention 

Start at temperature 
The logger will start at a specified temperature. User specifies if it is a rising or falling 
temperature that triggers the start. Time options are available as a backup should the 
temperature not be reached 

 

 

 

Alarm limits can be set for Over Temperature and Under Temperature. These would normally be set to levels acceptable 

for the environment in which the instrument is recording.  

 

 

An Instrument name can be entered into the Stainless Steel Pro Logger to aid the use of multiple loggers; this can be up 

to 31 characters except the following. \ / : * ? < > | - 

Stop Modes  

When connected to PC The logger will stop and the PDF document will be generated 

Stop when full The logger will take 16000 readings and then stop 

After x readings The logger will  stop at a selected number of readings (up to and including 16,000) 

Stop At Time The logger will stop at the specified date/time without further intervention 



  

Connecting Stainless Steel Pro to a Computer 

 

The Stainless Steel Pro logger is connected to a computer using a USB C lead. 

Unscrew the instrument end cap and insert the USB connector (Please note - the connector is NOT polarised and 

therefore can be inserted in either orientation). Push it in until a click is heard. 

Connect the other end of the USB lead to a spare USB port on your computer. 

Once connected, communications to the Stainless Steel Pro will automatically begin. The Stainless Steel Pro acts as a 

memory card and provides a PDF summary page of the logged data. 

Now that the PDF has been generated it is stored in the logger until a new log is started. 

 

On disconnection, remove the USB C lead from the instrument and ensure the end cap is screwed firmly back in place. 

 

Note - If it is the first time the Stainless Steel Pro Logger has been connected since a battery replacement then the PDF 

will need to regenerate and the unit will need a ‘Factory Reset’ in ThermaData Studio before use. If the PDF is required 

please open or save it before performing the ‘Factory Reset’. 

 

 

 

Battery Replacement 

 

Note - Removing the battery will NOT cause all stored readings to be lost 

 

The Stainless Steel Pro Logger battery has an expected life of 3 years at ambient temperatures. The case has a screw fit 

end cap which can be removed by unscrewing it. 

 

When removing the battery, it is important to note the orientation and polarity. 

 

It is recommended that only the Tadiran SL-561 2/3 AA batteries supplied by ETI Ltd are fitted. However if fitting a third 

party battery, fit only a 3.6V, 2/3AA size inorganic lithium battery that has an operational temperature range equal to or 

greater than the Stainless Steel Pro Logger (-20 to 125 °C). Fitting a third-party battery may significantly reduce the 

battery life of the instrument. 

 

Once the battery is fitted replace the end cap by screwing it back on. 

 

Once the battery has been replaced a factory reset is required before the Stainless Steel Pro can be used. 

 

 

Factory Reset 

 

The Stainless Steel Pro Logger can be reset to factory settings by selecting the ‘Factory Reset’ icon found in the 

‘ThermaData’ tab. 

A verification window will have to be acknowledged before the actual reset occurs as all settings, activities and data will 

be lost in the process. 

 

 



  

Setting Up Stainless Steel Pro Logger 

The set-up of the Stainless Steel Pro instrument can be achieved using the Settings window. This window can be 

accessed using the ‘Instrument Settings’ icon under the ‘ThermaData’ tab. 

 

 
 

Once the Settings window is open you may change any of the settings within the Stainless Steel Pro Logger. The 

following list shows the elements of the Settings window that can be modified: 

• Name 

• Battery Level 

• Alarm Temperature Limits – the over/under temperature alarm levels. 

• Starting Logger – the time the logger will wait before taking a reading after it has been started, a specific 
time/date to start the logger, or at a certain temperature. 

• Note - If the SS Pro Logger has already been started and is counting down the start delay, then the start delay 
time shown will be updated with the remaining start delay each time the logger is accessed. 

• Stopping Logger – the choice on how the logger stops taking readings. This can be done when the logger is full, 
after a set number of readings, or at a specific time/date. 

• Instructions – 7 lines of instructions to display on the PDF report when it is next generated. 

• Log Interval – how often your logger takes a temperature 
Note - the indicator below the dropdown box shows the total time before the memory becomes full. This 
automatically updates whenever the same rate is changed. 
IMPORTANT – if a 1 second Log Interval is selected; this will significantly reduce the battery life of the 
instrument. You will be prompted with the following warning:  

 

 
 
 
 
 
 



  

 
When you click on the ‘Instrument Settings’ icon you may be asked which communications method to choose from. 

Using the dropdown box select “Stainless Steel Pro Logger D********”. 

 

 
 

After the communications are complete the Settings window will open up. 

 

New settings cannot be sent to the logger unless it receives a ‘Stop’ command beforehand. 

 

‘Send Settings’ will send the new settings over to the Stainless Steel Pro Logger and put the logger in a “Start state”. 

This means the logger will not start until it receives a ‘Start’ command (see relevant help section). This function is useful 

for allowing a ThermaData Logger to acclimatise before starting. 

 

If new settings are sent to the ThermaData Logger you will be prompted that this will delete any existing settings and 

temperature data that are currently stored on the unit. 

 

IMPORTANT - This information cannot be restored once deleted. 

 

  



  

Viewing Status 

Getting instrument status will obtain all the current information from the logger (not the historic data) without 

interrupting it from its current set up. 

 

Press the ‘Status’ icon on the ‘ThermaData’ tab. 

 

 

Select which instrument you want to get the status from within the drop-down menu, and press ‘OK’. 

 

 
 

ThermaData Studio will open up a status window containing the following information: 

 

 

 

• Serial Number of Stainless Steel Pro 

• Instrument Name 

• Firmware version 

• Earliest and latest reading time/date 

• How the logger was started 

• Recording Interval 

• Sensor high and low alarm limits 

• Total time logging 

• Number of readings 

• Number of readings in alarm 

• Max temperature/average temperature/min 

temperature 

• Total time in alarm 

• Total time out of alarm 

• Battery Level 
 

 

 

 

There are also separate options to select ‘Reading Trim Info’ which will show the trim amounts, and the date the trim 

was set, as well as the ‘Internal Time Info’ of what time and date the SS Pro Logger last read. 

You can also download the readings via the ‘Download Now’ button, or open the generated PDF by clicking ‘Open PDF’. 

 

 



  

Downloading Data from a Stainless Steel Pro Logger 

Once the Stainless Steel Pro Logger has been plugged into the communications port you can select the ‘Download’ icon 

which can be found under the ‘Home’ tab. 

 
 

Select which instrument you want to download from within the drop-down menu, and press ‘OK’. 

 

 
 

Once you select the required option a communications window will open to indicate the progress of the download. 

 

 
 

The file will automatically be saved in the pre-set default directory by pressing ‘Continue’. This will be your ‘Documents’ 

folder as standard. You change the default directory by selecting ‘Change Default Destination Directory’ in the window 

that appears after a download, or via the ‘New Document Destination’ within the ‘Options’ dialog. 

 

 
 

To save the file as a different name or in a different location you can select ‘Save As’. 

The filename will be generated from the Title contained within the Stainless Steel Pro Logger. 

 

 

.Auto PDF 
When the Stainless Steel Pro Logger is initially connected to a computer it will automatically generate a PDF summary of 

the logged data.  

Once the PDF summary is generated you will be able to communicate with the logger through ThermaData Studio. 

The PDF summary will remain stored in the logger until a new log is started, at which time the PDF will be cleared, 

except when using the ‘Start at Time’ start mode, in which case the PDF will be cleared as soon as you disconnect the 

instrument from the PC. 

 

 

 

 

 

 



  

Data Retrieval 

 

If the instruments battery goes flat, when it is replaced the instrument will go through a data retrieval function which 

will read all of the readings stored in memory in order to create the PDF document. 

 

Note - If the instrument was logging at the time of power loss, it will not continue to log when the battery is replaced. 

 

 

Re-initialising a Stainless Steel Pro Logger 

 

Once a download has been completed you will need to re-initialise the logger to begin another logging cycle. 

The initialisation can be achieved in one of 2 ways: 

• Press ‘Initialise Existing Settings’ icon on the ‘ThermaData’ tab. This will re-initialise your Stainless Steel Pro 
Logger with the same settings used in the previous logging cycle. 

 

• Use the ‘Instrument Settings’ window and following the “Setting Up Stainless Steel Pro Logger” section. 

 

 

 

 

 

 

 

 

 

 

 

  



  

 

Reading Trim 

The Reading Trim facility can be accessed by clicking on the ‘Reading Trim’ button found on the ‘ThermaData’ tab. 

If you have multiple instruments connected to your PC you will have to select the correct serial number from the drop-

down box. 

Any data in the logger at this point will be lost so ensure all data is downloaded and saved first. 

 

 
 

The Stainless Steel Pro Logger must be allowed time to acclimatise in a controlled environment before the Reading Trim 

should be adjusted. The actual temperature of the controlled environment should be read from a certified, calibrated 

instrument. Now set the ‘Reference Value’ in the Reading Trim window to match the actual temperature. Once this is 

done, click the ‘Update Trim’ button. The Reading Trim of the Stainless Steel Pro Logger will then be set according to the 

reference temperature. 

 

It is recommended that the Reading Trim be set as near to the temperature that the unit will be recording in as is 

possible. 



ThermaData® Logger TC 

ThermaData® Logger TC Overview 

 

The ThermaData Logger TC is a waterproof, high capacity type K thermocouple logger, used to record 

temperature at specified intervals over the range -100°C to 1372 °C with a resolution of 0.1 °C and an accuracy of 

±0.4 °C.  

 

It has a 16000 reading capacity - if one input is used or an 8000 reading capacity if two inputs are used. 

The sample interval can be set anywhere from 6 seconds to 255 minutes in 6 second steps up to a minute, and 

then 1 minute steps. It can also be programmed with various start/stop modes: 

 

 
 

Start Modes  

Manual Start 
Start the logger either through the PC software or by pressing the button on the 
front case of the logger 

Start Delay 
After start applies a Start Delay from 1 second to 23 hours, 59 minutes before the 
first reading is taken 

Starts At Time The logger will start at the specified date/time without further intervention 

 

 

Alarm limits can be set for Over Temperature and Under Temperature. These would normally be set to levels 

acceptable for the environment in which the instrument is recording. 

The logger will indicate alarm status through LED flashes. For a description of the other LED indications, see the 

Button and LED indicators section. 

If your model includes an LCD then the logger displays which input is in alarm with text in the LCD. 

 

An Instrument name can be entered into the ThermaData Lite to aid the use of multiple loggers; this can be up to 

31 characters except the following. \ / : * ? < > | - 

The ThermaData Logger TC can also store trim data for improved accuracy. This feature can be password 

protected for security. The password is case sensitive and can be any characters except the following.   

\ / : * ? < > | - 

Stop Modes  

When connected to PC 
Stops the logger only through pressing the stop button in the software when 
connected to the PC 

Stop when full The logger will take 2 x 8000 or 16000 readings and then stop 

After x readings The logger will take x readings and then stop 

Stop At Time The logger will stop at the specified date/time without further intervention 



Connecting to a PC 

Connecting the ThermaData Logger TC is accomplished by connecting the USB lead to a spare USB port on your 

PC using the USB connector (the PC does not need to be turned off to do this). The bung in the ThermaData 

Logger can be removed and the other end of the USB lead can be inserted into the logger. 

 

On disconnection, remove the USB lead from the instrument and ensure the bung is pushed firmly back in place. 

 

Note - If it is the first time the ThermaData Logger has been connected since a battery replacement then a factory 

reset is advised. Any readings that were stored in the logger memory will be retained during the battery 

replacement and these may be downloaded before a factory reset is performed. 

 

 

 

Battery Replacement 

 

Note - Removing the battery will NOT cause all stored readings to be lost. 

 

The ThermaData Logger TC has a minimum expected life of 3 years. A battery level indicator in the application 

software will indicate the approximate battery level when the logger is accessed.  

The ThermaData Logger is constructed from a two-part case. The case can be opened by unscrewing the four 

retaining screws and removing the rear case. 

 

Once the case is apart the battery can be seen and removed manually. When removing the battery, it is important 

to note the orientation and polarity. The battery box is marked with the polarity for the battery.  The battery box 

will have a + and a - sign, the battery will have at least a + sign. These symbols must be aligned for correct 

polarity. 

 

It is recommended that only Tadiran SL760 batteries supplied by ETI Ltd are fitted. However if fitting a third party 

battery, fit only a 3.6V, AA size inorganic lithium battery that has an operational temperature range equal to or 

greater than the ThermaData Logger (-40 to 85 °C). Fitting a third party battery may lead to a significant reduction 

in the battery life of the instrument. 

 

Once the battery is fitted correctly, replace the rear case, and screw the screws in till hand tight.  

 

Once the battery replacement has been completed a factory reset is advised. Any readings that were stored in the 

logger memory will be retained; these may be downloaded before a factory reset is performed. 

 

To perform the factory reset, connect the ThermaData Logger and select the ‘Factory Reset’ under the 

‘ThermaData’ tab. 

 



Button and LED Indicators 

The ThermaData Logger has 1 button and 2 LEDs (one red, one green). 

 

 
 

The Start button, is used initially to Start the logging (can also be started from the PC software). 

Depending on the start mode chosen the requested Start Delay is initiated. After the required delay, the 

ThermaData Logger starts taking samples at the specified interval (the start instruction is acknowledged by both 

the red and green LEDs flashing together 4 times). 

 

After the ThermaData Logger has started logging, the LEDs will flash automatically to indicate the log alarm 

status. 

 

Below are descriptions for the possible LED signals: 
 
Red & Green LEDs flash together (four times) 
The ThermaData Logger has received a Start instruction, and has either started, or if there is a Start Delay set, 
then after the start delay logging will start at the specified sample interval. 
 
Red & Green LEDs flash alternately (four times) 
The ThermaData Logger has started, but not yet taken its first reading. This could be due to the Start delay, or the 
interval for the first sample has not yet elapsed. 
 
Red LED flashes (once every 12 seconds) 
The ThermaData Logger has been taking samples and at least one of the samples taken is outside of the specified 
Over / Under Temperature alarm levels. 
 
Green LED flashes (once every 12 seconds) 
The ThermaData Logger has been taking samples and none of the samples taken are outside of the specified Over 
/ Under Temperatures alarm levels. 
 
Red LED flashes twice (once every 12 seconds) 
The ThermaData Logger has been taking samples and at least one of the samples taken was outside of the 
specified Over / Under Temperature alarm levels, but the samples being taken have now returned to within the 
alarm levels. 
 
Red LED flashes three times (once every 12 seconds) 
The ThermaData Logger has logged one or more readings which are outside the operating range of the 
instrument. This may be because the thermocouple being measured has developed a fault (or has been 
unplugged). The log will contain readings marked 'Err' to denote this. If this problem persists you should contact 
the ThermaData Logger supplier. 
 
  

Start 

Button 

Green LED 

Red 

LED 



Setting Up ThermaData® Logger 

The set-up of the ThermaData TC Logger can be achieved using the Settings window. The Settings window can be 

accessed using the ‘Instrument Settings’ button under the ‘ThermaData’ tab. 

 

 
 

Once the Settings window is open you may change any of the settings within the ThermaData Logger.  The 

following list shows the elements of the Settings window that can be modified: 

 

• User ID (Log Title) 
Note - If any of the settings are changed the Title bar will show the original title followed by MODIFIED. 

• Battery Level  

• Alarm Temperature Limits – the over/under temperature alarm levels for both Input 1 and Input 2. These 
can be disabled by unchecking the tick box next to the relevant alarm. 

• Starting Logger – the time the logger will wait before taking a reading after it has been started, or a 
specific time/date to start the logger. 
Note - If the ThermaData Logger has already been started and is counting down the start delay, then the 
start delay time shown will be updated with the remaining start delay each time the logger is accessed. 

• Stopping Logger – the choice on how the logger stops taking readings. This can be done via the software, 
when the logger is full, after a set number of readings, or at a specific time/date. 

• Log Interval – how often your logger takes a temperature 
Note - the indicator below the dropdown box shows the total time before the memory becomes full. This 
automatically updates whenever the same rate is changed. 
 

When you click on the ‘Instrument Settings’ button you may be asked which communications method to choose 

from. Using the dropdown box select “ThermaData Logger TCD # D********”. 

 

Note - Checking the ‘Don’t show this every time’ box causes the application to automatically select the last used 

COM port. To change this setting once checked use the ‘ThermaData Logger – Selected Ports’ tab in the ‘Options’ 

dialog. 

 

 

 

 

 

 



Once you select the required option a communications window will open. All boxes will fill up with a green tick if 

the communication is successful. An unsuccessful communication will show a red X which may require you to 

unplug the instrument and retry. 

 

 
 

After the communications are complete the ‘Settings’ window will open up.  

 

If you have accessed the logger whilst it is currently taking samples there is an option to stop the logger if 

required. New settings cannot be sent to the logger unless it receives a ‘Stop’ command beforehand. 

 

‘Send Settings’ will send the new settings over to the ThermaData Logger and put the logger in “Start state”. This 

means the logger will not start until it receives a ‘Start’ command (see relevant help section). This function is 

useful for allowing a ThermaData Logger to acclimatise before starting. 

‘Start Logging’ will send the new settings over to the ThermaData Logger and start the logger at the same time. 

 

If new settings are sent to the ThermaData Logger you will be prompted that this will delete any existing settings 

and temperature data that are currently stored on the unit. 

 

Note- This information cannot be restored once deleted.  



Starting and Stopping  

Start 

 
The ThermaData Logger TC can be started via 2 ways within the software: 

 

1. Pressing ‘Start Logging’ within the Settings window. 

2. If the ‘Send Settings’ option has been pressed then the ‘Start’ button in the Control Ribbon can be 

selected. 

A manual (push button) start can be achieved by initialising the ThermaData Logger TC using the ‘Send Settings’ 

option in the software, then pressing the on-board button to commence logging. 

 

Start Modes Starting 

Manual Start Through the PC software 
or 
By pressing the button on the front case of the logger 
The first reading will be taken immediately 

Start Delay After start through the PC software or the button on the front case of the logger - 
the first reading will be taken after the Start Delay has occurred 

Starts At The first reading will be taken at the specified date/time without further 
intervention 

 

Stop 
 

The ThermaData Logger TC can be stopped either by using the application and selecting the ‘Stop’ button. This 

will not cause any data within the ThermaData Logger to be altered or corrupted. 

Alternatively, the ThermaData Logger TC can be stopped and started within the Settings window. Data can still be 

retrieved from the ThermaData Logger TC once it has been stopped.  

 

Stop Modes Stopping 

Software Stop Through the PC software 

Stop when full Through the PC software, or when the logger is full. 

After x readings The logger will take x readings and then stop 

Stop At The logger will stop at the specified date/time without further intervention. 

 

The ThermaData Logger can also be stopped and started within the Settings Window. This can be accessed by 

selecting the ‘Instrument Settings’ button within ThermaData Studio. 

  



Viewing Status 

 

Getting instrument status will obtain all the current information from the logger (not the historic data) without 

interrupting it from its current set up. 

 

Press the ‘Status’ icon on the ‘ThermaData’ tab. 

 

ThermaData Studio will open up a status window containing the following information: 

• Serial Number of ThermaData Logger 

• Status – active/not active 

• Time the logger started 

• Sample Interval 

• Current samples in logger memory 

• Start Delay 

• Setting on how the logger responds to a full memory 

• Sensor 1 (and 2) high and low alarm limits 

• Any alarms that have occurred 

• Last sample taken 

• Battery level 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are also separate options to select ‘Reading Trim Info’ which will show the trim amounts for Sensors 1 (and 

2), and the time and date the trim was set, as well as the ‘Internal Time Info’ of what time and date the 

ThermaData Logger last read. 

 

The ‘Status’ window can be refreshed via the ‘Refresh’ button and closed via the ‘Close’ button or the ‘Exit’ 

button on the top right-hand corner of the window.  

 
 

 

 

 

 

 

 

 



Downloading Data 

The data within a ThermaData Logger can be extracted without interfering with any current logging currently 

being undertaken and also without corrupting any of the existing data.  

 

Once the ThermaData Logger has been plugged into the communications port you can select the ‘Download’ 

button which can be found under the ‘Home’ tab. 

 

 
 

You will be prompted to choose which communications method to choose from. Select the correct instrument 

and click ‘OK’. 

 

Once you select the required option a communications window will open. All boxes will fill up with a green tick if 

the communication is successful. An unsuccessful communication will show a red X which may require you to 

unplug the instrument and retry. 

 

If the ThermaData Logger is currently logging while the download takes place you will also be asked if you wish to 

continue logging. 

 

 

 

The file will automatically be saved in the pre-set default directory by pressing ‘Continue’. This will be your 

‘Documents’ folder as standard. You change the default directory by selecting ‘Change Default Destination 

Directory’ in the window that appears after a download, or via the ‘New Document Destination’ within the 

‘Options’ dialog. 

 

 
 

To save the file as a different name or in a different location you can select ‘Save As’. 

 

 The filename will be generated from the User ID/Log Title contained within the ThermaData Logger and the start 

date/time of the log (first sample). 

 

 



Re-Initialising a ThermaData Logger 

Once a download has been completed you will need to re-initialise the logger to begin another logging cycle. 

 

The initialisation can be achieved in one of 2 ways: 

 

• Select ‘Initialise Existing Settings’ in the Control Ribbon. This will re-initialise your ThermaData Logger 
with the same settings used in the previous logging cycle. 

• Use the ‘Logger Settings’ window and following the “Setting Up ThermaData® Logger” help guide.  

 

Factory Reset 

The ThermaData Logger TC can be reset to factory settings by selecting the ‘Factory Reset’ option found in the 

‘ThermaData’ tab. 

A verification window will have to be acknowledged before the actual reset occurs as all settings, activities and 

data will be lost in the process. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Reading Trim 

The Reading Trim facility can be accessed by selecting the ‘Reading Trim’ option within the Control Ribbon. 

After you select which instrument you want to adjust the reading of the below window will appear 

 

:  

 

“Current Trim” shows the raw values which are the current temperature or humidity readings and any trim 

settings that are currently being used. The “Value Read” is the reading value after the trim has been 

impelemented on the “Raw Value”.   

“New Trim” provides you with a dropdown box to select how much trim you want to include on your ThermaData 

Logger sensor(s). 

 

The ThermaData Logger TC can be changed ±3°C at 0.1°C increments. 

 

The ThermaData Logger must be allowed time to acclimatise in a temperature controlled environment before the 

‘Reading Trim’ should be adjusted. The “Reference Value” temperature should be taken from a certified, 

calibrated instrument and then entered into the ‘Reference Value’ dropdown box. Once this is done, click the 

‘Update Trim’ button.  

Note - it is recommended that the Reading Trim be carried out, as near to the temperature that the unit will be 

recording in as is possible. 

 

A password can also be used which prevents users from adjusting the Reading Trim. The password is required to 

open the ‘Reading Trim’ window and modify the Reading Trim. The ‘CHANGE’ button allows you to change the 

Reading Trim password. The existing password is needed to change the password. 

 

If the Reading Trim password is forgotten, a factory reset will clear the password to nothing, although all data and 

settings will be lost. 

 

 



1 The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG Inc, and any use of such marks by Electronic 
Temperature Instruments Ltd is under license. Other trademarks and trade names are those of their respective owners. 

 

Classic BlueTherm® Instruments 

BlueTherm® Overview 
 

The BlueTherm Probe, BlueTherm Duo and BlueTherm One are accurate, easy-to-use temperature measurement 

devices which operate by connecting over an industry-standard Bluetooth1 connection to the PC. 

The ThermaData Studio operates with the industry-standard Microsoft or the Widcomm Bluetooth stacks 

installed on the PC, and can connect directly to a probe within the software. 

Connecting to Classic BlueTherm® Instrument 

1. To connect to one or more devices, press the ‘New’ icon under the ‘Home’ tab. 
2. The ‘Active Instruments” window will open as below: 

 

 
 

3. Click on the plus (+) symbol located at the bottom right of the window. 
4. Choose Classic Bluetooth instruments: 

 

 
 
 



 
5. You will then be presented with the below window and a list of device(s) that you can connect to. Select 

the devices that you want to connect to and press ‘Connect’. 
 

 
 

If the ‘Reconnect automatically’ option is selected, ThermaData Studio will attempt to automatically connect to 

this probe when you re-start ThermaData Studio. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Configuring a Classic BlueTherm® Instrument 

To configure a BlueTherm probe; select the ’Configuration’ icon on the BlueTherm tab. 

 

If you are connected to more than one BlueTherm probe, you will be asked to choose which probe you wish to 
configure. 

 
 

After selecting the BlueTherm probe you wish to configure, you will be shown a dialog which allows you to enter 

the settings you wish to use. 

 

 

 

 

 

 

 



Reading Interval 

By clicking on the ‘Reading Interval’ icon you will open a window allowing you to select the interval rate of your 

BlueTherm instrument. This is the time readings are taken and transmitted to the PC.  

 

Instrument Information 

To obtain information about a BlueTherm probe, select the ‘Information’ icon on the BlueTherm tab. 

If you are connected to more than one BlueTherm probe, you will be asked to choose which probe’s information 
you wish to see. 

 
 

After you select the probe, you will be shown its information. 

 

 



Disconnecting BlueTherm® Probes 

 
To disconnect a probe, click the ‘Disconnect’ button from the BlueTherm tab.  
 

 
 

If there is only one BlueTherm probe connected, it will be disconnected at that time. If there is more than one 
probe connected, select the one you wish to disconnect from the probe list. 
 

 
 

 
 
 
 
Charging BlueTherm Probes 

 
BlueTherm probes should be charged prior to use. To charge a probe, connect it to a USB port or a USB charger 
using a Type A to Mini B (5pin) cable. The probe can be charged when the probe is switched on or off. 
 
(The probe’s USB socket can be found under the rubber bung on its end cap.) 
 
A red LED light will show while the probe is charging. If the red LED light flashes while charging, an error has 
occurred. A charging error can be caused by three things: 

• There is a fault condition with the battery. (This may be temporary.) 

• The battery charge is very low. (Retrying to charge the probe again usually solves this error.) 

• The ambient temperature the probe is being charged in is below 10°C. 
 
To recharge the probe: Disconnect the USB lead and re-insert it into the socket. 
 
Note: Measurement accuracies are not guaranteed while charging. 



RF ThermaData® Logger 

RF ThermaData® Logger Overview 

 

The RF ThermaData Logger is used to record temperature at specified intervals and report this information to the 

PC. 

 
 

For the RF ThermaData Logger; over the range 40 °C to 125 °C (85 °C for an internal sensor) with a resolution of 

0.1°C and an accuracy of ±0.5 °C. 

The sample interval can be set anywhere from 1 minute to 255 minutes in 1 minute steps. It can also be 

programmed with a Start Delay from 1 second to 23 hours, 59 minutes. 

Alarm settings can be programmed into the RF ThermaData Logger for an Over Temperature and Under 

Temperature. These would normally be set to levels acceptable for the environment in which the unit is 

recording. The LEDs will flash at 12 second intervals, with a green LED indicating that the temperature has not 

gone outside the alarm levels, and a flashing red LED indicating that an alarm has occurred. For a more detailed 

description see the Button and LED indicators section. 

 

User identification can be entered into the RF ThermaData Logger to aid the use of multiple loggers; up to 32 

characters can be stored within the logger as the ID. This ID is case sensitive and can take any characters except 

the following: 

\ / : * ? < > | 

The RF ThermaData Logger can also store trim data for improved accuracy. This feature can be password 

protected for security. The password is case sensitive and can be any characters except the following: 

\ / : * ? < > | 

 

The RF ThermaData Logger can store up to 8000/16000 readings at any time. It can be set to stop recording once 

the internal buffer is full, or to loop back to the beginning and overwrite the oldest data (oldest data will be lost 

as it is overwritten). 

The RF ThermaData Logger interface buttons provide the ability to perform the following functions: - 

• Extracting Data 

• Control settings 

• Calibration & Test 

• Starting 

• Stopping 

• Initialising (for manual start) 

• Log Summary retrieval 

• Current temperature retrieval 

 

For a full explanation of these features, see the relevant help section. 



Battery Replacement 

 

Note - Removing the battery will NOT cause all stored readings to be lost. 

 

The RF ThermaData Loggers internal battery has a minimum expected life of 1.5 years. A battery level indicator in 

the application software will indicate the approximate battery level when the logger is accessed. If the battery 

expires the application software will inform you next time you attempt to access it. 

The RF ThermaData Logger is constructed from a two-part case. The case can be opened by unscrewing the three 

retaining screws and removing the rear case. The screws are retained by rubber seals (ensure these are not lost). 

Once the case is apart the battery can be seen and removed manually. When removing the battery, it is important 

to note the orientation and polarity. The battery compartment is marked with the polarity for the battery. 

It is recommended that only Tadiran SL750 batteries supplied by ETI Ltd are fitted. However if fitting a third party 
battery, fit only a 3.6V, ½AA size inorganic lithium battery that has an operational temperature range equal to or 
greater than the RF ThermaData Logger (-40 to 85 °C). Fitting a third party battery may lead to a significant 
reduction in the battery life of the instrument. 
Be sure to fit the battery in the correct orientation. The battery compartment will have a + and a - sign, the 
battery will have at least a + sign. These symbols must be aligned for correct polarity. 
Once the battery is fitted correctly, replace the rear case, and screw the screws in two turns. 

Stretch the seal (with the narrower lip towards the rear case) over the case and allow the tongue to drop into the 

gap between the case halves. Once in place tighten the screws fully; but do not over tighten. 

Once the battery replacement has been completed a factory reset is advised. Any readings that were stored in the 

logger memory will be retained; these may be downloaded before a factory reset is performed. 

To perform the factory reset, see the relevant help section. 

 



Buttons and LED indicators 

The RF ThermaData Logger has 1 internal reed switch and 2 LEDs (one red, one green). 

 
The reed switch, in conjunction with a magnet, is used initially to Start the logging (can also be started from the 

PC software). The magnetic start is performed by touching the smaller end of the magnet fob flat against the rear 

of the logger, over the magnet symbol on the rear label. 

From the point at which the start is requested the Start Delay is initiated. After the required delay, the RF 

ThermaData Logger starts taking samples at the specified interval (the start instruction is acknowledged by both 

the red and green LEDs flashing together 4 times). 

After the RF ThermaData Logger has started logging, the LEDs will flash automatically to indicate the log alarm 

status every 12 seconds. 

 

Below are descriptions for the possible LED signals: 

Red & Green LEDs flash together (four times) 

The RF ThermaData Logger has received a Start instruction, and acknowledges that the start delay has been 

initiated (after the start delay logging will start at the specified sample interval). 

Red & Green LEDs flash alternately (four times) 

The RF ThermaData Logger has started, but not yet taken its first reading. This could be due to the Start delay, or 

the interval for the first sample has not yet elapsed. 

Red LED flashes (once every 12 seconds) 

The RF ThermaData Logger has been taking samples and at least one of the samples taken is outside of the 

specified Over / Under Temperature alarm levels. 

Red LED flashes twice (once every 12 seconds) 

The RF ThermaData Logger has been taking samples and at least one of the samples taken was outside of the 

specified Over / Under Temperature alarm levels, but the samples being taken have now returned to within the 

alarm levels. 

Green LED flashes (once every 12 seconds) 

The RF ThermaData Logger has been taking samples and none of the samples taken are outside of the specified 

Over / Under Temperatures alarm levels. 

  



Setting Up RF ThermaData® Logger 

 

The set-up of the RF ThermaData Logger can be achieved using the Settings window. The Settings window can be 

accessed by clicking on the ‘Instrument Settings’ button under the ‘ThermaData’ tab. 

 
Once the Settings window is open you may change any of the settings within the RF ThermaData Logger. The 

following diagram shows the settings window: 

 

The following list shows the elements of the settings window that can be modified: 

 

• User ID (Log Title) 
Note - If any of the settings are changed the Title bar will show the original title followed by MODIFIED. 

• Battery Level  

• ThermaData Real Time Clock – synchronise the logger’s clock with the PC time and date. 

• Alarm Temperature Limits – the over/under temperature alarm levels. 

• Data Storage – if the memory becomes full would you like to overwrite the oldest data, or stop taking 
samples. 

• Start Delay – the time the logger will wait before taking a reading after it has been started. 
Note - If the RF ThermaData Logger has already been started and is counting down the start delay, then 
the start delay time shown will be updated with the remaining start delay each time the logger is 
accessed. 

• Time Interval – how often your logger transmits a temperature 
Note - the indicator below the dropdown box shows the total time before the memory becomes full. This 
automatically updates whenever the same rate is changed. 
 
 
 
 
 
 
 
 
 
 



Starting and Stopping 

 
Start 
The RF ThermaData Logger can be started within ThermaData Studio in 2 ways, or it can be manually started. In 

the software you can start the logger by: 

 

Pressing the ‘Start’ button in the Control Ribbon. 

 

In ‘Instrument Settings’, press the ‘Start Logging’ button 

 

A manual (magnetic) start can be achieved by initialising the RF ThermaData Logger using the software, and then 

by touching the smaller end of the magnet fob flat against the rear of the logger, over the magnet symbol on the 

rear label. 

The first reading will be taken immediately. 

 

Stop 

The RF ThermaData Logger sampling activity can be stopped by using the ‘Stop’ button in the Control Ribbon.  

 
 

Alternatively the RF ThermaData Logger can be stopped within ‘Instrument Settings’ window by choosing the 

‘Stop Logger’ button. 

 

 

 

 

 

 

 

 

 

 

 



Downloading Data 

The data within a ThermaData Logger can be extracted without interfering with any current logging currently 

being undertaken and also without corrupting any of the existing data.  

Once the ThermaData Logger has been plugged into the communications port you can select the ‘Download’ 

button which can be found under the ‘Home’ tab. 

 

 
 

A communications window will open. All boxes will fill up with a green tick if the communication is successful. An 

unsuccessful communication will show a red X which may require you to retry. 

If the RF ThermaData Logger is currently logging while the download takes place you will also be asked if you wish 

to continue logging. 

 

 

 

The file will automatically be saved in the pre-set default directory by pressing ‘Continue’. This will be your 

‘Documents’ folder as standard. You change the default directory by selecting ‘Change Default Destination 

Directory’ in the window that appears after a download, or via the ‘New Document Destination’ within the 

‘Options’ dialog. 

 

 
 

To save the file as a different name or in a different location you can select ‘Save As’. 

 The filename will be generated from the User ID/Log Title contained within the RF ThermaData Logger and the 

start date/time of the log (first sample). 

 

 

 

 

 

 

 

 

 



Status 

Getting instrument status will obtain all the current information from the logger (not the historic data) without 

interrupting it from its current set up. 

 

Press the ‘Status’ icon on the ‘ThermaData’ tab. 

 

ThermaData Studio will open up a status window containing the following information: 

• Serial Number of ThermaData Logger 

• Status – active/not active 

• Time the logger started 

• Sample Interval 

• Current samples in logger memory 

• Start Delay 

• Setting on how the logger responds to a full memory 

• Sensor 1 (and 2) high and low alarm limits 

• Any alarms that have occurred 

• Last sample taken 

• Battery level 
 

 

 

 

There are also separate options to select ‘Reading Trim Info’ which will show the trim amounts for Sensors 1 (and 

2), and the time and date the trim was set, as well as the ‘Internal Tim Info’ of what time and date the 

ThermaData Logger last read. 

 

The ‘Status’ window can be refreshed via the ‘Refresh’ button and closed via the ‘Close’ button or the ‘Exit’ 

button on the top right-hand corner of the window.  

 

Re-Initialising a ThermaData Logger 

Once a download has been completed you will need to re-initialise the logger to begin another logging cycle. 

The initialisation can be achieved in one of 2 ways: 

• Select ‘Initialise Existing Settings’ in the Control Ribbon. This will re-initialise your ThermaData Logger 

with the same settings used in the previous logging cycle. 

• Use the ‘Logger Settings’ window and following the “Setting Up RF ThermaData® Logger” help guide 

(from the application using the “Logger Settings” button).  

 

Factory Reset 

The RF ThermaData Logger can be reset to factory settings by selecting the ‘Factory Reset’ button in the Control 

Ribbon. 

 

Several verification windows will have to be acknowledged before the actual reset will occur as all settings, 

activities and data will be destroyed in the process. 



Reading Trim 

The Reading Trim facility can be accessed by selecting the ‘Reading Trim’ option within the Control Ribbon. 

 

After you select which instrument you want to adjust the reading of the below window will appear:   

 

 
 

If your RF ThermaData Logger has 2 sensors you will get the option to adjust the reading on both (temperature). 

“Current Trim” shows the raw values which are the current temperature readings and any trim settings that are 

currently being used. The “Value Read” is the reading value after the trim has been implemented on the “Raw 

Value”.   

“New Trim” provides you with a dropdown box to select how much trim you want to include on your RF 

ThermaData Logger sensor(s). The minimum and maximum trim values for RF ThermaData Loggers are ±3°C at 

0.1°C increments 

 

The RF ThermaData Logger must be allowed time to acclimatise in a temperature controlled environment before 

the ‘Reading Trim’ should be adjusted. The “Reference Value” temperature should be taken from a certified, 

calibrated instrument and then entered into the ‘Reference Value dropdown box. Once this is done, click the 

‘Update Trim’ button.  

  

Note - it is recommended that the Reading Trim be carried out, as near to the temperature that the unit will be 

recording in as is possible. 

 

A password can also be used which prevents users from adjusting the Reading Trim. The password is required to 

open the ‘Reading Trim’ window and modify the Reading Trim. The ‘CHANGE’ button allows you to change the 

Reading Trim password. The existing password is needed to change the password. 

 

If the Reading Trim password is forgotten, a factory reset will clear the password to nothing, although all data and 

settings will be lost. 

  



USB Probe 

 

USB Probe Overview 

The USB Probe is an easy-to-use, accurate, temperature measurement device which operates by plugging straight 

into a PC’s USB port. Once plugged in, there are no drivers and no dialogs to click. 

The device will automatically be recognised when you start ThermaData Studio. If ThermaData Studio is already 

operating and a USB probe is plugged in, the probe will automatically appear in the Live Summary. 

The USB Probe utilises a NTC thermistor sensor and allows the user to display the temperature over the range of -

40 to 125 °C with a resolution of 1 or 0.1 °C/°F, with an accuracy of ±0.5 °C. 

 

 

Connection of USB Probes 

The connection of USB probes relies on Windows USB device handling. The USB probe is shown in the ‘Device 

Manager’ within the ‘Control Panel’ as a Human Interface Device (HID). Windows USB controllers may sometimes 

temporarily disconnect existing probe connections when a new probe is connected. The connections will then be 

re-established. If you are planning to log data, please ensure that new probes are not connected during the log, as 

this may cause missed readings while the new probe is recognised by the Windows controller. 

If a probe becomes disconnected the data on the PC screen will be greyed out. 

If for any reason the probe does not reconnect please contact your IT department initially and if this is 

unsuccessful, contact ETI Ltd Technical Sales Team for further advice. 

 

USB probes are compatible with all USB communication standards. 

 

Probe leads may be extended by using a USB-A Male to Female extension lead. 

 

 

Probe Power 

The USB probe is powered from the USB port, typically using 40mA continuous current. Up to 16 probes may be 

connected to a PC via USB hubs. USB hubs can be powered or unpowered. If a large number of probes are to be 

plugged into one hub, or hubs are daisy-chained it may be necessary to use powered hubs. 

 

 

 

 

 

 

 

 

 

 

 

 



Configuring USB Probes 

 

 

Configure – allows you to configure settings on your USB probe such as: 

• Title/Name of the USB probe 

• High Limit 

• Low Limit 

• Offset/Reading Trim 

Reading Interval – allows the user to determine the reading interval of the USB probe between 1 second to 1 day 

intervals. 

Information- gives you information about your USB probe such as: 

• Title/Name of the USB probe 

• High Limit 

• Low Limit 

 

 

Data Readings 

USB probes will appear in the ‘Active Instruments’ window and will update based on the Reading Interval you set 

under the ‘Reading Interval’ button.  

 

 



SMS Alarms via Clickatell™ 

SMS Alarms Overview 

 

The Clickatell SMS function allows you to use SMS sending services provided by Clickatell to provide SMS 

notifications when a sensor exceeds its alarm limits. 

SMS is a method of delivering 160-character messages to mobile phones and landlines around the world. 

This function requires that you have a separate contract and account with Clickatell, who retain responsibility for 

the delivery of the SMS messages. 

The SMS function will send one SMS to each of the mobile numbers listed in the ‘SMS – Options’ tab. 

Clickatell™ is a trademark of Clickatell (Proprietary) Limited of South Africa. 

 

 

 

 

 

 

 



Getting a Clickatell™ account – Platform accounts 

1. Select ‘Options’ from the ‘File’ menu. 
2. Choose ‘SMS – Account’, ensure ‘Platform’ is selected and click the ‘Sign Up’ link. 

 

 
 

 
3. Fill in the details to create an account; this will automatically accept the Clickatell Terms and Conditions. 

 
 

4. You will be sent an email with your details, follow the link to log in. 
5. Enter the username and password you filled in earlier. This will take you to your home page. 
6. Choose ‘SMS Integrations’ and create a new integration. Once complete make a note of the API key. 

 

 
7. Purchase credit and make the integration live. 



Entering Account Details – Platform accounts 

1. Choose ‘SMS– Account’ and ensure ‘Platform’ is selected. 

 

2. Enter the API key you created in step 6, and any ‘From’ number you created on Clickatell’s website  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Managing Phones to be notified 

1. Choose ‘SMS – Options’ 

 

2. Enter phone numbers in the international format. For example, if your UK mobile number is 

07700900604, click after the + and enter 447700900604. 

3. You will then receive text messages whenever a probe goes into/out of an alarm 

 

Managing which alarms to send messages on 

 

1. Choose ‘SMS – Alarm Filter’ 

 

2. For each Probe you do not wish to receive alarms, un-tick the relevant box [Enter High Limit, Leave High 

Limit, Enter Low Limit or Leave Low Limit]. You can also set a variable time delay before any texts are sent 

which helps with preventing false alarms during defrost cycles. 

Enter High Limit - when a sensor exceeds its higher alarm limit 

Leave High Limit - when a sensor falls back below its higher alarm limit, and within its limits 

Enter Low Limit - when a sensor exceeds its lower alarm limit 

Leave Low Limit - when a sensor falls back above its lower alarm limit, and within its limits 



Active Instruments 

Monitoring wireless instruments via Active Instruments 
 

‘Active Instruments’ is the main location to view all your wireless instruments. This view is 

compatible with ThermaData WiFi, Bluetooth LE, Classic USB Probes and Classic BlueTherm 

instruments. It will automatically appear when you start ThermaData Studio if the device support for 

these instruments is turned on in ‘File > Options’. It will display all available instruments in as 

‘Active’, ‘Late Instruments’ or ‘Removed’. 

 

 

 

 

The default layout shows the following columns: 

Sensor Name Shows the name of the sensor 

High Limit Shows the current High Limit set for the instrument 

Low Limit Shows the current Low Limit set for the instrument 

Reading Shows last transmitted reading from the instrument 

Last Updated Shows when the last reading occurred 

Access Level Shows Full or Read access 

Auto Archiving Shows whether you are auto archiving this instrument (green), not auto-
archiving (red) or auto-archiving isn’t supported for this instrument (-) 

Configure Shows a list of actions available for each instrument 

Extra Columns available are: 

Instrument Name Shows the name of the instrument 

Serial Number Shows the serial number of the instrument 

Next Update in Shows the anticipated time till the next reading is transmitted to Studio 

Battery Level Shows the battery level of the instrument at the last update 

Signal Strength Shows the signal strength reported by the instrument at the last update 

Measurement Interval Shows the measurement (logging) interval the instrument is set to 

Transmission Interval Shows the transmission interval the instrument is set to 
 



To change the information displayed, right click on the title of any of the columns you will see the 

following options: 

 

1. Hide that specific column. (Sensor Name, Reading, Last Updated and Configure cannot be 

hidden) 

2. Manage Layout. You can move columns between ‘Available Columns’ (not shown) and ‘Show 

these Columns’ (shown) by selecting them and clicking ‘Add’ or ‘Remove’ as appropriate. 

Press OK to confirm these changes. (Hold Ctrl to select multiple) 

 

 
 

3. To restore the layout to its default, click ‘Reset layout to Factory Defaults’. This will return 

the view to the default layout, as shown previously. 

 

Late Instruments 

Any instruments that do not successfully communicate for 2x transmissions (plus 1 minute) will 

automatically move to a ‘Late Instruments’ group. Each instrument will continue to re-connect, but 

ThermaData Data Studio will display the instrument in this way. If this occurs, please check the WiFi 

signal strength at the location of the instrument and/or the battery level of the instrument. 

 

 



Managing wireless instruments via Active Instruments 
 

To manage an instrument within the ‘Active Instruments’ window, right-click on the instrument 

name in your list, or click on the ‘…’ icon at the end of either sensor row for your instrument, and 

choose an action from the pop out window.  

With a ThermaData WiFi that is connected with full access and isn’t auto-archiving, you will get this 

menu: 

 

With a ThermaData WiFi that is connected with read only, you will get this menu: 

 

With a ThermaData WiFi that is connected with full access and is set to auto-archiving, you will get 

this menu: 

 

With a Bluetooth LE instrument connected, you will get this menu: 

 

On all these options screens you can change and configure each instrument and how it interacts with 

ThermaData Studio. 

 

 



Any sensor that has exceeded its high limit will become shaded in red. 
Any sensor that has exceeded its low limit will become shaded in blue. 
 

 

 

 

Alternative ways of viewing Data 
 

 

Whilst using an ‘Active Instruments’ window you will be able to view the live data in multiple ways: 

• Graph opens up a new window displaying a line graph of all sensors currently being 

monitored. All new readings will be populated into this graph. 

• Active Instrument is activated when new window is opened. 

• Alarm History displays a list of all alarms that have occurred since the Live Summary window 

was opened. Information provided is the serial number, instrument name and alarm 

description of what occurred. A ‘Clear’ button can be used to ignore any unwanted alarms. 

• Data shows a table of temperature readings taken by each sensor and the date/time these 

readings were taken. 

• Data Summary shows an easy-to-view breakdown of each sensor, including information such 

as; probe name, number of samples, the maximum, minimum and average values recorded, 

alarm levels and the number of times any alarms occurred. 

• Probe Map allows you to visually display where the readings are being taken from within the 

workplace. 

• Span Window shows the difference in temperature between the highest and lowest reading 

of instrument sensors within the Live Summary window. 

 

 

 

 

 

 

 



Data Tab 
 

When you press Data in the Views Ribbon the data that has been captured into the software will be 

shown in a table format. A Data tab will also appear along the top of ThermaData Studio. These extra 

tools provide the ability to manage how the data is shown: 

 

Average, Maximum, Minimum, and Span adds additional columns into the data table showing 

further temperature statistics. 

If you have an instrument that has temperature and humidity sensors then a separate ribbon will be 

shown for Humidity Statistics.  

 

AutoScroll determines whether the data table automatically scrolls to show you the newest reading. 

Unselect to deactivate the function. 

 



Data Summary Window 

 

When opening up a saved ThermaData Studio file, a graph will appear along with a Data Summary 
window. This window provides an overview of the entire data file which has been collected in an 
easy-to-view summary. 
 

 
 

The ‘Data Summary’ tab shows information on the log title, when the log started and finished, the 
maximum, minimum and average values recorded, the duration of the log, alarm levels and the 
number of times any alarms occurred. 
 
A saved file that has multiple instrument or sensors saved within it, will look slightly different. This is 
an example of a saved Auto Archived files of 3 ThermaData WiFi instruments 
 

 
 



The ‘Alarm Information’ tab shows a history of each time an alarm occurred; including details of the 
date and time the alarm started and the duration. There are separate boxes for high alarms and low 
alarms. At the bottom of each alarm box a total time in alarm is shown. 
 

 

 

‘Additional Information and notes’ will automatically be populated with the information acquired 

from the ThermaData logger. The “User Notes” box can be used to enter information on why certain 

alarms were exceeded, etc.  

 



Probe Map 
 

This feature enables you to visualize the readings being taken and show where they are in the work 

environment. 

 

When you click on the ‘Probe Map’ option in the ‘Views’ Ribbon a blank Probe Map will appear and 

also a new tab called ‘Probe Map’. 

 

To add probes into the map press Select Probes. This will open up a new window allowing you to 

select the sensors you have paired with your ThermaData Studio. Once you have selected the 

probes you require press ‘OK’ to continue. 

To move an item, click on the reading with the mouse, and drag it to its location. 

 

 

 



Other options within the ‘Controls’ ribbon are: 

 

• Select Map allows you to change the background image or floorplan 

• Select Probes allows you to choose which sensors to show on the Probe Map 

• Lock Map prevents the probes being moved around in the window. 

• Add/Open Probe Map opens another ‘Probe Map’ view. You can have up to 4 maps open at 

once. 

• Delete Probe Map deletes the current probe map. 

These options can also be accessed by right-clicking within a probe map: 

 

• Name… - changes the name of this probe map 

• Map… - enables changing of the background picture/diagram. This can be selected directly 

from your PC via the Windows Explorer. 

• Probes... - enables the choice of which probes to show on the probe map 

• Lock - Locks all maps belonging to this document 

• Show Descriptions - chooses whether or not the descriptions for the items are shown. 

• Save Maps as Default - this will save your current layout as the default layout when you 

next open a new Probe Map. 



Data View 

Single and Dual input loggers 

Once the data has been captured into the software, this tool provides an easy way to view the 
data in a tabular format.  
 

 
 

This shows the data, with the time in the first column and then the results for each probe in the 
requisite column. 

 

There is a ‘Data’ ribbon that provides additional display options:  

 

 
 

The buttons turn on/off columns showing Temperature Statistics 

 

 
             

The buttons turns on/off columns showing Humidity Statistics 

 

 

 

 

 



Multiple live instruments 

 

 
 

When live readings are being collected for multiple instruments the format of the Data Summary 
changes to a multi-column view to give an overview of each instrument. 

 

The ‘Data’ ribbon that provides additional display options remains the same.  

 

The ‘AutoScroll’ button on the ‘Data’ ribbon 

 

 
 

Determines whether the list automatically scrolls to show you the newest reading (or not). 

 

            

 



Span Window 

 

This window provides a snap-shot of the span between the highest and lowest readings of ‘live’ 
USB and BlueTherm sensors. It shows the span across all the latest readings.   

 

 
 



Alarm History 

 

Alarm history overview 

The alarm history enables the simple viewing in one place of all alerts which have been 
generated in ThermaData Studio. You can then clear them once you have dealt with them.  

To look at the alarm history, click on the “Alarm History” button in the home tab: 

 

To clear alarms, click the ‘Clear’ button on the right hand side of this alarm. 
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